Amstrad plc - Memorandum

Date:		27th May, 1997
To: 		PcW16 “Anne” users
From:		The PcW16 development team
Subject:	Useful information

=== Introduction ===

Thanks for buying a PcW16. While it was being developed a large number of machines were sent out to testers. While they were using the machine a large number of questions were asked. As you may also benefit from the answers to those “Frequently Asked Questions” they are included here in this FAQ document. In addition to the questions and answers, this document also describes the use of a couple of new program we have supplied on the OS Rescue Disc. The “Word Match” and “Data List” programs are described below:

If you have a problem then we would highly recommend you start by looking at the FAQ for the answer. One useful thing to know is that because this is a word processor document you can, of course, use the find command ([Ctrl]+F) to look for subjects. So, for example, if you are curious as to why # signs appear in the spreadsheet just press [Ctrl]+F then enter # and press /  - that will take you straight to the relevant question and answer. (You may have to press F1 to skip the character on the lines above).

=== Word Match program ===

A number of people have asked whether there will be any other programs made available for the PcW16 - we have had a Q/A about this in the FAQ for several weeks now, in which it said that a number of things were in development. Just to prove that this is not so called "vapourware" (i.e. software that is talked about but never materializes) we are including a program on the enclosed rescue disc that we hope most people might find useful.

To run the program, start at the opening desktop screen and then access the Tasks menu. Make sure the OS rescue disc is in the drive then select the "Run external program". A file selection dialog will appear and will show one program “Word Match” in the list. Select this then press the /  key. This will run the Word Match program.


The program loads a dictionary of words from the disc (different to the 48,000 built into the PcW16 - just 35,000 words but a quite different collection). It then presents a dialog for you to type words into. If you intend to use the program a lot it would be worth using the file manager to copy it and the Word List to the cabinet so that it loads much faster. The only problem is that it occupies a HUGE amount of space so perhaps this is not so desirable unless you are going to use it a lot and don't mind losing the space that could otherwise be used for storing documents.

The idea of the program is that it can be used for solving crossword puzzles. So if you know that a word is seven letter word - a, blank, blank, r, blank, blank, s - then enter a??r??s and press the /  key - the program will present all seven letter words with letters in the given positions.

The general method of use is to type the letters you know and put question marks where a letter is unknown. The program then returns all words that match the given pattern. Obviously the more letters you give the smaller the number of returned words will be. If, for example,  you just used ?e???? to list all six letter words who's second letter was `e� then there would be so many words listed that they fill the screen - press the space bar to see the next screen full.

As well as using a question mark for each unknown letter you can also use an asterisk to say “any number of unknown letters”. So "play*" will match with all words starting "play" however long they are. "a?e*s" will match with any words whose first three letters are 'a' then anything then an 'e' but of any length finally ending in an s.

The program has another couple of functions - the second function is to return all anagrams of a given set of letters so if you enter "testing" and then click the Decode Anagram button before clicking Find/  it will return anagrams of the given pattern. The pattern you use can include question marks and asterisks to say either a fixed or variable number of unknown characters.

The third and final function is to create anagrams. Click the Make Anagram button then enter the word(s) you want to find anagrams for (spaces can be included in this), you can type words that must be present in the given results into the “mask string” box but leave this blank if you want all solutions below this you will see three choices of how deep a search should be made. Normal and Extended will only return complete anagrams but the latter searches more deeply. If Partial is selected then some of the suggestion will end with a ">" character followed by any letters that couldn't be fitted into a solution. Click the Find/  when all options have been set.

For example,  click the Make Anagram button then enter "Tony Blair", then click Find/  (by default this leaves `mask string� blank and Normal selected) it will then try to find most of the possible anagrams (several of which are quite amusing!). The dots show it is 
"thinking". If the screen fills press Y for more or N to stop searching. You can also press [Stop] to stop searching any time. While it is searching and displaying dots you can press a number key and the search will be modified so that solutions just include words of that length or shorter.

=== Data List program ===

There is a second example program on the supplied disk. This is called “Data List” and has really been designed to help keep an ordered grocery shopping list but it could be used in other areas where a simple record of `stocks kept� against `stocks needed� has to be kept with the final printing out of a `shopping list� when needed.

The program has built in help that describes most of the operation. It is supplied with an example grocery list where you can say how many of each item you normally require and how many you actually have. As you use items you reduce the “actual” values, then before a visit to the shops you can print out a shopping list which will list any items where the actual number held is less than the number normally required - for each it shows how many must be bought to bring the stocks back up to the right level.

You can add new items to the list and delete existing ones from it. You can also import a list from some other computer/program that has been stored in CSV format. Equally, you can export the list to a CSV file that could then be taken to some other program/computer.

=== Frequently Asked Questions (FAQ) ===

During the test programme, as well as bug reports we have seen quite a lot of interesting operational questions so rather than respond to each individually we thought it best to make this a Frequently Asked Questions (FAQ) document so that others may benefit from the answers. Remember that you may be able to use the Wordprocessor find command to search for a question on a particular subject you are interested in. So, on to the questions, in no particular order...:

Q: How can I clear the calculator memory except by storing zero in it.
A: You can't - that's EXACTLY the suggested method to clear the calculator memory. This method of operation is the same as that used on many models of Casio calculator.

Q: Page Up/Down move a screen at a time - how can I easily navigate to the previous/next actual page breaks?
A: Just use Page Up/Down with the [Shift] key held.

Q: How do I select "No printer" if I don't have a printer available?

A: You cannot, the WP (and to a lesser extent the SS) rely on a printer being chosen so the right set of "typographic font files" are copied into the Cabinet. The WP simply cannot operate without a set of typo fonts available. However, if you don't have a printer at the moment, it doesn't matter which printer on the list you choose. Even if you make the wrong choice and choose a printer that has 300dpi resolution when you later come to print on a 360 dpi printer or vice versa - as long as you use Desktop/Setup/Setup printer to tell the system which printer you are using before finally printing the files they will be adjusted to the new font resolution.

Q: How do you include a tab character in a find/replace string?
A: Sorry but we're afraid you can't.

Q: How do you include style/font change codes in a find/replace string?
A: Afraid you can't do that either.

Q: Is there any way of producing fixed pitch text apart from numbers?
A: Not at present. The system as shipped only has two fonts available - Swiss and Times - it is planned that other fonts will be made available in future and these may include fixed pitch fonts (such as a font like Courier New that you may have seen in Windows on a PC). Numbers can be in a fixed pitch for vertical alignment of columns by marking the text and setting it to have the text style “Numbers in columns”.

Q: Is the calculator example on page 40 of the manual correct?
A: Oops, no, the correct numeric answer is 58.75 - at least the calculator gets the right result even if the book is wrong!

Q: I keep seeing "####" in the spreadsheet in place of some of my numeric entries. What's happening?
A: This is a feature of the spreadsheet (similar to Excel in Windows). Instead of only showing part of a number that won't fit within the current width of a column it will show # characters. It does this to prevent misleading you (if you saw 1234 as the company profit when it should really show 123456, but that wouldn't fit, you probably wouldn't be too amused!).

If the column's width is increased then the true result will be seen. It may also help to reduce the number of digits displayed by applying/editing formats. A common place where '#' characters are seen is in the rightmost column of the display - often this is only showing half a column so the width is severely reduced. Once you scroll sideways so that the complete columns comes into view the '#'s should be replaced by the proper numbers.

This has become such a common question that the help in the spreadsheet has been updated to include some extra notes about this.


Q: In the spreadsheet, how can I repeat a formula across a row of several cells or down a column of several cells?
A: Put the cell cursor on the cell to be repeated and either drag out a single line or single column selection area then use the Edit/Fill across or Edit/Fill down menu commands. These will adjust any coordinate references within the copied cells to be relative to the position from which the original cell was copied.

Q: How can I put a dividing line on a spreadsheet printout?
A: This can only be done by putting a text string in a row of it's own built up of underline, hyphen or equal characters - there is no dedicated line drawing facility.

Q: In the word processor how can I arrange for every paragraph I type to be justified?
A: Start a blank document then click Style/Edit a Paragraph Style, this will probably allow you to edit a style called “default”. Make sure that it's "following style" is set to [Same style] then click the Para. Format button and click the Justified box. Finally click OK twice. Each paragraph you type will now be justified. However, as you type a paragraph you may see that the right hand edge is ragged. If you stop typing for about 10 seconds the "auto reformat" will redraw the paragraph with a properly justified right edge. If you want to see this sooner then pressing the green key always makes an auto-reformat happen immediately. Auto reformat will also occur if you move the cursor off a paragraph you've just been editing.

Sometimes what you see on screen may not look exactly justified but you should find it prints correctly. This is because of the limited resolution of the PcW screen that only shows 640 horizontal dots while a 300dpi printer on A4 paper has 2,400 dots to play with.

Q: Printing seems very slow - is there any way to speed it up?
A: The way the PcW works is that it effectively draws a complete image of the page to be printed inside it's own memory and then sends this to the printer as a pattern of on/off dots in "graphics" mode - it does it this way rather than using the fonts within a printer so that it can do all the different point sizes, bold, italic, underline styles that it offers. These would not be available if it used the printers "text" mode. Unfortunately this process is very complicated and time consuming and there isn't a lot that can be done to increase the speed of printing. Not that it helps much, but the situation is very similar for people printing TrueType documents from Windows on a PC.

Q: In the WP I moved the cursor onto a line and pressed [Home] but it is still several inches from the left hand edge of the screen - what's going on?

A: Either, the paragraph into which the cursor has been positioned is set to be centred - use Style/Change Paragraph Format and change it from Centred to one of the other options such as Left-aligned. This will just affect the single paragraph in which the cursor is positioned. If you want this change to apply to all paragraphs in the document that have the same style then use Style/Edit a Paragraph Style and then change the "Para. Format" within that.
Or, the paragraph has an indent. If you look at the tab ruler at the top of the screen you'll see two half black triangles towards the left hand side. The top one shows the point to which the first line of a paragraph will be indented and the bottom one shows the point to which all subsequent lines will be indented. Use the Styles/Change Para format or Styles/Edit a para style/Para Format buttons to either change the indent on a single para or on all similar paragraphs throughout the document.

Q: How can I save a document (or spreadsheet) and continue editing?
A: Press [Task]+[F8] - this performs a "Save and Continue" operation. Alternatively click on the "Tasks" menu entry at the top left of the screen and then click the "Save and Continue" entry.

Q: How is the PcW16 better than previous PCWs?
A: The one major reason for changing the PCW design so drastically was to be able to show different sized fonts and styles such as bold and italic on the screen. The way that Locoscript worked with hidden codes was starting to look a bit dated when compared to all the modern WYSIWYG (What You See Is What You Get) word processors that people have come to expect in systems such as Windows. This meant writing a brand new word processor from scratch to draw characters on screen in graphics mode rather than using just fixed sized, simple text mode characters such as those used in LocoScript. 

To do this requires a huge amount of extra computing power compared to the previous PCWs and so the electronic design of PcW16 uses a 16MHz Z80 processor instead of the 4MHz Z80 used in previous models (that's the very reason it is called PcW16!). Only by using a processor running four times as fast is it possible to do all the extra calculations of working out where variable sized characters should be positioned on the screen as you type and still work at an acceptable speed. 

In some ways the PcW16 word processor isn't quite as powerful as Locoscript (it's options for headers and footers are certainly more limited) but we hope we have taken the most widely used features of both Locoscript and many other Windows based word processors and made a package that isn't too daunting in its complexity but, on the other hand, provides sufficient features to keep the majority of customers happy.

Q: "View tabs and returns" setting is not saved with a document - is this right?

A: That's correct, the setting is only a temporary thing to give a quick check where these "hidden" items are. Each time you start editing the option will be switched off.

Q: The pictures throughout the user manual show an extra "Demos" entry on the desktop screens - I don't see this on my machine, am I missing something?
A: No, unfortunately the screens for the manual had to be produced very early in the project and at that time the software had some extra testing/demonstration functions which were only used during development to test things as each new feature was added. This is not an omission from the final software - just an error on the part of the person who produced the screen dumps.

Q: How do I set a print area in the spreadsheet?
A: Drag the mouse (or use Shift+cursor keys) to select the area that you want to print and then use Spreadsheet/Set Print Area to tell the system that only that area should be used in printouts. Once a print area is set if you use "set print area" again but with only a single cell selected (or the entire sheet) then the print area will be set back to print as much of the spreadsheet as it possibly can fit on a page starting from the current cursor position when the print operation is started.

=== New entries for 2nd edition ===

Q: It seems that the only way I can see where page breaks will occur is by using print preview. Is there some other way to determine this?
A: Yes, press [Ctrl]+T (which is the same as selecting "Re-paginate Document" from the Document menu). This makes the word processor work through your document and put in dotted "soft" page break lines where the breaks will be at printing time. It is necessary to press [Ctrl]+T rather than have the word processor doing this automatically as it is a procedure that can take several seconds and it would be annoying if the WP kept doing this automatically.

Q: If I don't like the place where the WP has put in a page break what can I do?
A: Either select Insert Page Break from the Insert menu or, even quicker, press [Ctrl]+[Return] to insert a "hard" page break where you want the current page to end. It will appear as a thin solid line on screen. You can delete it like a normal character if you later want to remove it. The calculation of where "soft" page breaks appear when you re-paginate with [Ctrl]+T starts again for a new page when a hard page break is encountered during re-pagination.

Q: How can I save a copy of my address book or diary appointments to a floppy disk?
A: If you are not confident in the use of the file manager then just use Backup Cabinet to Disc to copy all your files to a blank floppy disc - included in these will be the address 
book and diary. Later use Restore Cabinet from Disc to read them back again if you need to return to the saved copies for some reason.

If you are more confident about using the file manager then you can copy the address book and diary appointments individually without having to use a completely blank disc or wait for the entire contents of the cabinet to be backed up.

The address book and diary are just held in two normal files in the cabinet. You don't normally see them because instead of being saved in Folders 01..16, they are stored in a special folder within the cabinet called the “system” folder.

To gain access to the system folder click on the View menu and then select the Show Cabinet System Folder option. (A quick way to do this is to click on the white on black word `cabinet� that appears above the listing of files). Once the system folder is showing you will see a whole host of files including all the different fonts that the system uses, it's help files and so on. If you look down this list you should see files called “Address Book” and “Diary Appointments”, these are the two files that you need to copy to a floppy disk. Click each name with the mouse so that it is highlighted and then press the Blue key to copy them. When asked for a destination pick any folder on a floppy disc. This will have made secure copies of those files.

Later, to restore the disc copies. Start by viewing the disk contents ([Ctrl]+L) then make sure the cabinet system folder is visible (by the View menu entry). Select the files saved on the disk and press Blue to copy them. For the destination select cabinet folder “System”. You may be asked if you want to over-write existing copies. Remember that if you do this any new entries made since you copied the files to disc will be lost but assuming this is what you want go ahead and press [OK/ ].

Q: Why cant the PcW16 show which line the cursor is on and how many lines are on a page like Locoscript used to?
A: The difference between Locoscript and the PcW16 is that in Locoscript all lines were exactly the same height so if you told it that you were using A4 then it knew for certain that (perhaps) there were 56 lines on the page and an indication such as 42/56 told you that you were ¾  of the way down a page. The PcW16 word processor is different because it has so many more sizes of font (10) compared to the single one in Locoscript. If you have a piece of paper that is almost twelve inches high with a one inch margin at top and bottom then there is almost ten inches that will actually be used for printing. If you type in 72 point text then you will only get 6 lines on such a page whereas if you type in 6 point you would get 96 lines in the same area. Normally the machine uses 12 point so that gives about 42 lines to the page.


As you can probably see the WP can't say that there are "xx lines" on a page because for all it knows you might change from 72 point to 24 to 10 to 6 at various points down the page and so the number of lines that might fit is completely variable (between 6 and 96 in the above case). Similarly, showing that you are on line 24 (for example) tells you nothing about how far down the page you are while editing. In 12 point that is about half way down the page but in 6 point it is less than ¼ . The only way you can really see how a page will look when printed is to use Print Preview and that is exactly why that function exists.

Having said all that, the software now has a status line at the bottom of the screen that will indicate which page and line you are on. You may find this useful for gauging how far down a page you are if you stick to using a single font size but if you use multiple fonts you may find print preview is a better way to see page layout (print preview also now includes an indication of page number).

Q: How can I get vertical columns of numbers to align in the wordprocessor?
A: The first important thing to note is that you cannot guarantee vertical alignment if you use spaces to move an item to a particular column. You must use Tabs. Secondly the fonts used by the PcW16 are “proportional” which means that thin characters such as 1,l,i appear on screen and printer much thinner than 0,O,W,M, etc. So a number such as 123.45 will not vertically align under 823.45 because 1 is thinner than 8:
	123.45
	823.45
The way to overcome this is to mark the numbers as a block and then use the Style menu's Change Text Style entry to set the text to be `Number in columns�. That makes all the selected numbers and spaces of equal width so a 1 and an 8 will be the same width and those numbers will align vertically:
	123.45
	823.45
One other point - if you are working on columns of numbers are you sure the wordprocessor is the best tool to use? - the spreadsheet's sole purpose in life is to operate on columns of numbers and it does it a lot better than the word processor!

Q: The scratchpad only holds one item whereas many sections could be stored in Locoscript. Is this a backwards step?
A: It's true that the “scratchpad”, like the “clipboard” in Windows, can only hold one item at a time but don't forget that areas of the document can be marked and then stored as “phrases” using the Store Selection as Phrase entry on the edit menu. Phrases can later be reinserted using the Insert Stored Phrase entry on the Insert menu.

Q: A disc that came with my printer mentions “Windows”, how do I use this disk on the PcW16?

A: You can't - that disc is inserted by the printer manufacturer in all the printers they produce and is intended for use by customers who buy the printer for use with an IBM compatible PC running Microsoft™ 's Windows™  operating system. It has no relevance for the PcW16 which uses an entirely different type of font to those that may be included on that disc.

However, although that disc is of no use for the PcW16, don't lose it! If you later upgrade to using an IBM PC compatible with Microsoft Windows then you will definitely need that disc.

Q: I can create new templates but how do I delete old ones?
A: Templates are stored in a special folder within the cabinet called the “system” folder. In the File Manager, to gain access to the system folder click on the View menu and then select the Show Cabinet System Folder option. (A quick way to do this is to click on the white on black word `cabinet� that appears above the listing of files). Once the system folder is showing you will see a whole host of files including all the different fonts that the system uses, it's help files and so on.

Within the list you should see the word processor template files. Next to each template name is a box containing a grey `blob�. Other files have different symbols next to their names - fonts have an F, help files have an H and special system files have a !. You can delete any of the templates that you no longer require except for the special one called “Blank template”. You cannot delete that one because the wordprocessor cannot be used if there were no templates and that one is protected against deletion so that there will always be one available.

Q: How can I enter an appointment in the diary without setting a time?
A: As soon as you have entered the message (“Cliff's birthday” or whatever) just press the green /  key instead of pressing [Return] for 'More'.

Q: Apart from the programs built into the machine are there any other programs I can run on the PcW16?
A: Not at present but the PcW16 has been designed to take new programs and these will be run using the “Run external program” entry on the Tasks menu.

Many of the developers who wrote programs for the previous PCW models have indicated that they will be converting old favourites and writing new programs for the PcW16. A little bird suggested that their might be as many as 30 programs in development at this time.

[Later] The Word Match program on the supplied disk is an example of such an external program - hopefully the first of many.


[Later still] Creative Technology have programs available for the PcW16. To find out details of what is available fill in and return the postage paid registration card that you will find in the PcW16 box.

Q: Do I have to wait for the spreadsheet screen to redraw every time I make an entry?
A: No, by default the spreadsheet has “Auto recalculation” switched on so that each time you make an entry it recalculates and redisplays all cells but as a sheet grows large the delay involved each time can become tiresome. To overcome this go to the Options menu and click on Auto-Recalculate to switch the feature off (the tick will disappear). When auto-recalc is switched off the sheet is not recalculated for each entry but this does mean that you can get cells that are `out of date�. In this case you can force a recalculation at any time to bring the display up to date by selecting Recalculate Now from the Spreadsheet menu. If you switch auto recalc back on then that will also perform a recalculation at that moment as well.

Q: How can I print from the address book?
A: The address book program does not have a print facility built in but that's because the wordprocessor can be used to print address book entries and doing it this way means you have total control over which entries are printed, how they are laid out and which fonts and styles are used.

Just use Insert Mail-Merge Code on the Insert menu to put codes into a document. You can choose from any of the fields that appear in the address book.

When you come to print a document that has mail-merge codes the wordprocessor detects the special {xxx} codes and puts up a dialog that allows you to select which entries in your address book will be used during printing.

Q: When I use the supplied letter template all my typing starts offset to the right by 3.9" (99mm). Why?
A: The address lines of the supplied letter template have a 3.9" indent (which you will see on the ruler bar as one of the solid black triangles being moved over to that position). If you don't want that indent then use Change Paragraph Format on the Style menu and change the 1st Line / LeftIndent value back to 0.


=== New entries for 4th edition (there were none for 3rd) ===

Q: Why is it that every time I start a new document or try to edit an existing one an attempt is made to read from the floppy even though there isn't a disc in there?
A: You have used the "change default storage" entry in the File menu of the File Manager. If you switch it back to cabinet normality will be restored.

Q: Why is that often the first file listed when I try to import from a Locoscript disc cannot be read?
A: You will probably see that the file that cannot be imported has a name ending .GRP - this is a special, normally hidden, file used by Locoscript to record the group names so, for example, you might see a file called LETTERS.GRP on the Locoscript disk and the group it is in will be "LETTERS". It's not surprising that the word processor complains about such a file as it is not a Locoscript document - because it isn't!!. Similarly there may be other files on Locoscript disks (xxxx.JOY, SETTINGS.STD etc, etc) which are listed but which are not Locoscript documents. Presumably you will know the names of the "real" documents you have recorded on your own disks.

Q: Why is it that it sometimes switches into italic (or bold, or underline) while I'm typing? and, how do I stop it?
A: There are several ways to switch bold, italic and underline on or off. Amongst these is the use of the letter keys B, I or U when pressed while holding down the [Ctrl] key. If you inadvertently press [Ctrl] when you meant [Shift] (for example starting a sentence with a capital B, I or U) you may switch on one of those styles when you didn't intend to. If this happens then press B, I or U with [Ctrl] held down to switch the relevant style off again. If you have already typed some text and want to change it's style then see the next Q/A....

Q: How can I change words that I've already typed to/from bold/italic/underline or a different font/size?
A: The answer is using block marking. Move the cursor to the start of the area you want to affect and mark the start of the area with either 1) a click of the middle mouse button, or 2) Using Mark Start on the Edit menu, or 3) Click the onscreen "marker" button that is next to [Spell] at the top right of the screen, or 4) Press the M key while holding down the [Ctrl] key (which is the shortcut shown for Mark Start on the Edit menu). There is a "hidden" 5th method which is to use [Ctrl] + the open square bracket key (I added this as I find Ctrl+[ and Ctrl+] very easy to remember as ways to set the start and end marks because the bracket characters give a mental picture of surrounding the intervening area of text).


Once the start mark is set (which is shown by the left hand bracket being illuminated on the on screen marker button) move the cursor to the end of the area you want to apply a style to and then set the end mark. There are a number of ways to do this: 1) Click the right hand mouse button, or 2) Use Mark End on the Edit menu, or 3) Click the onscreen marker button a second time, or 4) Press D while holding down the [Ctrl] key, or 5) use [Ctrl] and close square bracket (my fave!).

As soon as you set the end mark the onscreen marker button will show both brackets illuminated and the visible portion of text between the start and end mark will be highlighted in reverse text on screen.

At this point, if you decide not to change the text, there are several ways to unmark the highlighted selection 1) Use Undo Selection on the Edit menu, or 2) Click the onscreen marker button a third time, or 4) Press the Z key while holding  down [Ctrl].

If you want to change the position of the start or end of the marked area then just move the cursor to the new start/end and use one of the methods above to set that marker's position.

Once a section is marked the whole block is assumed to have the same font and style attributes as the first character in the block. So if it is bold (for example) then the whole block is treated as if it were bold (even if some parts are not).

The onscreen bold/italic/underline buttons can be clicked to quickly change the style of a block. Entries on the Style menu can also be used for this. The Change Text Style entry on the Style menu also allows the font and size to be changed as well.

Once you have finished changing a marked selection area you can unmark it using one of the methods listed above. Additionally, you'll find that the selected area is automatically unmarked anyway as soon as you start to enter new characters.

Q: Are there any "hidden" features in the software?
A: That's actually quite a broad question as there a number of things the software will do that weren't mentioned in the manual. Some of these were additions after the manual went to print and some are there mainly for our internal use but others may well find them useful. In no particular order:

Normally the word processor saves documents compressed to make the most efficient use possible of cabinet or floppy disk space (sorry for the inconsistency of the use of "disk" and "disc" in this document - I personally always use the American "disk" but keep trying to correct it to the more correct "disc" while typing this - sorry if I missed any). Anyway, the WP normally saves compressed but if you press [Task], [Shift] and [Blue] then compression will be switched off, press the same keys again to switch it on again 
(the change is only while you are still using the WP, next time you start it will be back to compressed). This option is probably unlikely to be of any use to anyone but me. (cos I wrote the compression system).

Talking of funny key combinations. There is a very powerful but VERY DANGEROUS key combination which is if you hold down the righthand [Task], [Shift], [Ctrl] and [Red] keys at switch on the machine will automatically go into the process of loading a new operating system from a rescue disc. All files in the cabinet will be lost so you'd be very unwise to experiment with this without at least doing a backup first! For this to work the keys must be held down after the power switch is pressed. It can take about 10 seconds before the total reset is initiated.

In the spreadsheet, if you click on the filename display on screen it will do the same as pressing [Task]+[F8] - that is a save and continue. Similarly, if you click on the box where it shows you the current cell it will immediately bring up the "Go to" dialog.

In the WP, I'm not sure if this made it to the manual but tabs can be set and cleared most easily just by clicking on the tab ruler display. This is far quicker than Change Tab Positions on the Style menu (though perhaps less accurate).

The File Manager has lots of hidden goodies but these should not be used by the uninitiated as you may render your system so unusable that it has to be restored from a Rescue Disc. Most of the functions can't be accessed unless the current folder being shown on screen is the cabinet "system" folder. So step one is to switch to that. After that, most of the extras cannot be used until the system folder has been "unlocked". This is done by pressing [Task]+X. You'll know you've done it right if there is an asterisk next to the cabinet percentage free figure. Once the cabinet is unlocked all those system files (the ones with ! in a box next to them) can now be deleted or have new files copied over them. Previously you would just have got a message saying the files could not be deleted.

Another of the File Manger "hidden" functions is [Task]+[#], this allows you to specify a file specification which limits the types of files displayed. So, for example, if you set it to be *.WPD then only word processor documents will be listed. Set it back to *.* (or just *) to make it show all files again. (To see the other file extensions such as WPD see the following description of Task+R)

If you use [Task]+[M] then when you next try to read a floppy disk it no longer has to be a PcW16 one - you can take a "normal" MS-DOS one and it's files will be listed with just 8.3 filenames instead of the special 32 character file names that PcW16 uses.

Using [Task]+[R] will reveal the three letter extensions on each file. For example, Word Processor documents are *.WPD, templates are *.WPT, spreadsheets are *.SS, etc. When you rename files (even without using Task+X or Task+R) you can specify an 
extension to be used to over-ride the existing extension by including a quote and three letters at the end of the new name. That quote must be the one typed using the key beneath STOP on the keyboard.

[Task]+[H] shows hidden files but this may be a bit disappointing as there only normally is 1 hidden file - a file that records information about the file manager's current configuration.

[Task]+[Undo] is VERY DANGEROUS - it formats the cabinet memory so that all existing files are lost and should only ever be used if you want to start with a "clean" machine. You MUST backup any files you want to keep first.

[Task]+[N] will get rid of the "index" file in the cabinet that holds the names assigned to FOLDER01, FOLDER02, etc. so they'll revert to the default names.

[Task]+[P] will force a purge of the cabinet. This is the process that often happens after files are newly written or deleted when you see "Freeing cabinet space", "Re-shuffling cabinet", or whatever. Basically, remnants of old files remain even after deletion but are just marked as reusable. However it is only when a purge is performed that the space they occupy really is totally wiped and made ready to accept new files - as I say, this normally happens automatically when needed anyway.

Finally in the file manager there are a couple of shortcuts available using the mouse. The first is a quick way to access the System folder in the Cabinet or on a disc - just click the mouse on the word “Cabinet” or “Disc” that appears on the title bar across the screen. The other is a quick way to make the program read a floppy disc. Normally when you put in a floppy you have to access Change Disc on the Disc menu or press [Ctrl]+L, an even quicker way is to click the right mouse button.

I guess that's it for the file manager - there's even a hidden feature in Help but that's all I'm going to say on that subject!

Q: Can crashing the software actually damage the machine?
A: No, don't worry, the worst that can happen is that you have to reload the operating system from a Rescue Disc. Now I know that's bad enough but that really is the worst damage you can do to it.

Q: How can I get from field to field in the address book while editing an entry?
A: Well you can use the [Return] key after entering each field (name, address, tel, etc.) to move to the next one but more generally you can use the [Tab] key to go from one field to the next and [Shift]+[Tab] to go back to previous fields.


This isn't just limited to the address book. You can use [Tab] and [Shift]+[Tab] to move from item to item in most dialogs within the PcW16 software. You will normally find that pressing the [Space] bar has thee same effect as clicking the mouse on a selected item. In fact the whole PcW16 software has been designed so that it can still be operated if you don't have or choose not to use a mouse.

Q: While I can import files from an old PCW (Locoscript and CP/M) into the PcW16 I can't see any way to transfer things back the other way?
A: This is correct -- we' like to think that you wouldn't find it necessary to do this (but I know some people have reverted during testing to be able to use the more stable PCW8xxx/9xxx software). The fact is that the system can happily read and write MS-DOS format floppy disks (PcW16 disks are effectively just a "normal" MS-DOS disk with some added bells  and whistles) but it can only READ from CP/M (which includes Locoscript) format disks. This means that import from them is possible but export to them is not possible.

=== New entries for 5th  edition ==

Q: How can I go back and change my name and address details that I entered when I first set the machine up?
A: From the desktop access the Setup menu. On there you will find entries for changing the date and time and beneath that is an entry for "Enter user information" this is where you can change the details of your name/address/telephone number, etc. - At the end of that process a couple of new word processor templates (letter and fax) are created to include the updated information you just entered. Obviously this operation should also be performed if the machine is passed on to or sold to a new owner.

For the highly technically minded you may like to know that it is possible to create other "special" templates that take on the user information to build "normal" templates at the end of the process of entering the user info. Those files are made just like a normal template but you insert mail-merge codes where you want the items filled in with user details. The file must be saved uncompressed (so use Task+Shift+Blue in the WP) and after saving you should change the name from a .WPT to a .WTT (Wordprocessor Template template) and add any 3 characters to the end of the normal name. So if you wanted to create one for memos you'd actually make a new (uncompressed) template as "MemosXXX" and then use Task+R in the file manager to access extensions and change the file in the system folder from WPT to WTT. When the entering of user information is completed a new template "Memos" would then be created incorporating the user information wherever there were previously mail merge codes.

Q: Can you lock a row and column in the spreadsheet containing titles so that they do not move while the rest of the sheet is scrolled?

A: Not at present but this feature is definitely something that will be added to a wishlist for a future version should we choose to develop the software further.

Q: Is it possible to upgrade the hardware?
A: The PcW16 has 1MB of Flash memory (half holds the operating system and programs, the other half is the Cabinet). It also has 1MB of DRAM which is the memory used while documents/spreadsheets/etc are actually being edited/printed - it also hold the screen memory and various operating system resources.

The circuit board inside the PcW16 has been designed so that it is very easy to add another 1MB of flash and another 1MB of DRAM. The extra megabyte of flash would all be used to increase the cabinet size so you could, for example, hold hundreds of documents inside the machine and also have room for new fonts as they are produced. The extra megabyte of DRAM would allow larger documents to be edited and would help printing large and complex documents (especially on OKI printers).

Amstrad do not intend to provide an upgrade service but a company we are in contact with has expressed an interest in doing this. This will probably be advertised widely in the PCW press when available.

Q: Is there a magazine specifically for the PcW16?
A: Unfortunately there is no longer a magazine available in the high street dedicated to the PCW but there are a few independent Amstrad user groups who produce  club magazines that have information relating to the PcW16 and other Amstrad computers.  Contact details are as follows:

PCW Today
150 Oxford Road
Middlesborough
Teesside
TS5 5EL			Tel: 01642 816903

8 Bit
Harrowden
39 Hight Street
Sutton-in-the-Isle
Ely
Cambs.
CB6 2RA			Tel: 01353 777006

The Disc Drive
10 Sheridan Avenue

Thundersley
Essex
SS7 1RD			Tel: 01702 551618

In addition to these national support groups there are a number of local user groups for PCWs. You will find lists of these in the above publications

Q: I'm preparing a book about the PcW - how can I produce screen dumps?
A: As you already know, the [Print Screen] key will send the current screen to a printer. If, however, you press [Shift]+[Print Screen] with an MS-DOS format floppy disk in the drive the screen will be written to disk in .BMP format (as used by Windows paint programs). Each time you capture the screen like this a numbered file with a name SCRSHTnn.BMP will be written to the disk.

Q: How can I "relay" text like I use to in Locoscript to see the text instantly redrawn after making an insertion in a paragraph?
A: Press the Green /  key for an instant reformat. Or, if you stop typing for about ten seconds or if you move the cursor off a paragraph into which you have inserted text then the reformat also happens then.

Q: Is it OK to always leave the machine plugged in and just switch it into "Standby" so that the power switch turns red rather than switching off at the wall and/or unplugging it?
A: Absolutely, that's exactly how it is designed to be used. You should never need to unplug the PcW or switch it off at the wall unless you intend moving the unit. Think of it just like a TV, video or microwave oven - those are devices you always leave plugged in and switched on it's just that they are normally switched to "standby" when you switch them off (via the remote control for example).

It is only by leaving the machine on in standby that it can "wake up" to sound an alarm when you have set diary appointments. Also, the battery that powers the onboard clock is a NiCad battery that periodically needs recharging (this all happens invisibly "behind your back"). If you leave the machine totally unplugged for several weeks (probably months) that battery will run down and when you next plug in and switch on the PcW you'll probably be asked to set the time and date again.

=== New entries for 6th edition ==

Q: What is the spare 9 pin socket on the back of the machine, next to the mouse port, used for?
Nothing at present, it is a "serial port" that is spare and could be used in the future for connecting to other computers or to connect to a modem so that the PcW16 could be used as an email and/or internet terminal.


Q: How can I get Locoscript documents from the 3" disks on my old PCW into the PcW16?
A: Locoscript (10 Vincent Works, Vincent Lane, Dorking, Surrey, RH4 3HJ) have a package called “Locolink” available which can be run on the old PCW. The PcW16 already has part of Locolink built in and if a cable connecting to Locolink running on an old PCW is detected when you call up the PcW16 file selector to Import a file, it will automatically offer the option of copying across files from the 3" disks on the other machine.

Q: Has the method of deleting files in the file manager been changed?
Yes, it does not operate in quite the same way as described on page 136 of the manual. A lot of people found the original method a bit complicated so the method of operation has been changed to be consistent with the way the rest of the File Manager (and all other PcW16 software) operates. Once you have selected one or more files. When you then select Delete you will just see an "alert box" asking you to confirm that this is what you want. It is no longer necessary to select the files a second time before they can be deleted.

Q: How can I see the various style, font and size codes in my document?
You cannot, there is no way to “show codes” however this does not mean you can't tell exactly where they are. For one thing, because the word processor is WYSIWYG (What You See I What You Get) you can tell where the codes are anyway because if a word is in bold then you can see that on screen. Obviously there is a bold code on either side of that word `bold� on the line above.

However suppose you want to go back and continue typing in bold you'd want to be sure of being on the left hand side of the bold code at the end of the word before you start typing. If you cursor up to that line to the right of the word and then press the ®  cursor key across the word `then�. As you reach the right hand side of the `d� at the end of word `bold� notice that the bold button at the top right of the screen is still off. Now press the ®  key once again and notice how the cursor does not move but the bold button at the top of the screen switches to on. This small step over a code without moving the cursor is know as a “micro-step”.

The use of such micro-steps can be more generally useful any time when you want to get on the “other side” of a code. For example. If you started a line by changing to bold and then typing text (like the Q:.... lines in this document), then on such a line you can press [Home] and the button at the top right of the screen shows that your are still to the right of the the bold code. If you then press the ®  key you can move to the  other side of the code and type non bold text at the very start of the line.

Normally the cursor right key ¯  automatically steps over to the right of a code but you can then use ®  to micro-step back if you need to.


Q: What do the various bits of information on the status line at the bottom of the screen show?
The first, important, thing to know about the status line is that it is only updated in idle moments when you are not doing anything so it's best to stop typing for one or two seconds before reading the information.

The first entry on the line tells you which Style the current paragraph is based on. Often this will be “Default” but that changes when you use Style/Use a Paragraph Style and it may be different if you have created your own new templates with different default style names.

Next is the Page number. This can only be relied on 100% immediately after the document has been repaginated (such as Document/Re-Paginate Now - [Ctrl]+T). At any other times you may have inserted new lines which will have changed where the page breaks will occur so the current position of page breaks is “out of date”.

The paragraph number is the number of the paragraph that the cursor is in counting from the very start of the document.

The line number is the number of the line that the cursor is in on the current page counting from the start of document or the previous soft or hard page break. Like the page number this info may be “out of date” unless a repagination has just been performed.

Following the line number is the name of the current font and the point size. Micro-steps (described in previous answer) may be used to get to either side of a font or size change code and the status line together with the bold/italic/under buttons at the top right of the screen help you to determine exactly where the cursor is positioned.
(Note: It is NOT possible to show codes.)

After the font and size comes the state of insertion. Normally insert is ON so if you put the cursor in the middle of an existing word and type a gap opens up to accomodate the new letters you type. If you press the [Insert] key on the keyboard or click the top entry in the Insert menu then insert is switched off and the WP switches to over-write mode so that as characters are typed with the cursor on top of some existing text the previous letters are removed before the new ones appear.

The final entry on the status line shows whether you have modified the text since loading the document. If, for example, you select Document/Abandon before the text has been modified the WP exits immediately but if the text has been modified then you are offered the option of cancelling the abandon. Several functions behave differently depending on whether the text has been modified or not (e.g. Revert to saved, Save and continue, etc).


Q: What does “Freeing cabinet space” mean?
Flash memory holds the files in the cabinet, it cannot be erased every time a file is written as this takes a long time and would reduce it's working life. So, instead, when a file is written to flash the old copy is left there but just marked “dirty” and the new one is then added. Eventually, when there are enough old, “dirty” files the software decides it is time to erase all the old copies to make some new, free space available. It is while it is doing this that you see the message.

Q: What are the function keys (F1..F7) used for in the wordprocessor?
The function keys can be used as a quick method of applying a style to an entire paragraph. The various options are:

	F1	Left aligned
	F2	Centered
	F3	Right aligned
	F4	Justified
	F5	Bold
	F6	Italic
	F7	Underline

Q: Is there anyway I can more easily edit 6 and 8 point text in the wordprocessor?
Unfortunately because the screen tries to give a true representation on screen of the relative text sizes as they will appear on the printed page the 6 and 8 point text are very small and, what's more, the limited screen resolution means that they cannot be seen too easily.

One way to overcome this is to edit the text in a larger point size (12 point say) then mark the area as a block and use Style/Change Text Style to reduce it down to 6/8 point but the problem is that the layout wwill change once you do this.

The other way is to use a hidden feature in the wordprocessor. If the Task, Shift and Yellow keys are pressed together the bottom status line will be changed to show some internal information about the way the word processor is operating. This is really for our technical support people but there are several displays available. If you keep pressing Task+Shift+Yellow, after "Mem4" has been displayed the next display shows the text near the cursor in a font that is hopefully large enough for you to edit. The position of the cursor is shown with a vertical line. An alternative (more technical) display of the same thing is shown if you press task+Shift+Yellow again. If it is pressed once more you will return to the normal status line dispyay.


=== New entries for 7th  edition ==

Q: Why do the OKI printer drivers have the word (restricted) on the selection menu?
A: Unlike other printers for which the PcW16 can build the image to be printed in small stripes and send each individually to the printer, the OKI printers, due to their lack of internal memory, require the PcW16 to build the complete page image in memory before it is all sent to the printer in one go. The 1MB of DRAM memory in the PcW16 is only just enough to accomodate this and as soon as a range of fonts or other special effects are used it is possible that the limit will be exceeded and the page will become just too complicated to print on an OKI printer.

Q: When will more fonts be available for the PcW16?
A: While it will be possible for Creative Technology to make some of the fonts they designed for previous PCW products available for the PcW16 there is a fundamental reason why this is unlikely to happen in the short term. The fact is that a font (such as the Swiss or Times that is supplied) is stored as a number of files within the System folder in the Cabinet. For each font there are about 10 files and together they total more than 100K of space in the cabinet.

Normally when you first start to use the PcW16 there is just over 200K of free space in the Cabinet and as soon as you have written a few documents this space will be depleted. If you wanted to add even a single additional font to the machine it would immediately occupy more than 100K of that limited cabinet space leaving virtually no room for you to save documents. Therefore the only practical way to add fonts to a machine would be to first upgrade the size of the Cabinet flash memory from it's normal 1MB size to 2MB but it is not yet clear who will offer this service and if it is offered it may be too prohibitively expensive to be commercially viable.

Q: Why are there 21 styles available? In fact, what are “style”s used for anyway?
A: As you are typing a document you may choose to highlight a word by putting it in bold for example. Which you do by just pressing [Ctrl]+B before and after the word.
You may even decide to type a whole paragraph in italic which you could either do by pressing [Ctrl]+I at the start and end of the paragraph or, first type the paragraph and then mark it as a block and apply the italic style to the marked block.

However, those things only affect the single word or single paragraph that you just typed. If you were, for example, writing a technical report and had major headings which you wanted to appear in Centered, Swiss 18 point bold, minor headings that you wanted in Swiss 14 point and the body text of your document that you wanted in 11 point Times it would be a real pain if you had to switch on all those effects each time you got to a 
heading and then switch them all off again as you went on to type paragraphs of body text.

Far easier would be if you had a number of definable “style”s where you could predefine one, called “Major” (say) as Centered, Swiss, 18 point, bold another, “Minor”,  as Swiss, 14 point and the third, “Default” as Times, 11 point. Then, each time you type a major heading you just type the text then apply the “Major” style to it and all those special features are automatically applied. What's more, once you've finished writing the document, if you decide that the Minor heading would be better in Italic then you just edit the “Minor” style and all occurences of paragraphs throughout the document that have a “Minor” style will instantly be changed.

The PcW16 allows you to have 21 different styles in each document (should be more than enough for most people!). You define and edit the features applied for a particular style using the Edit a Paragraph Style... entry on the Style menu. You use a particular style that you have defined by using the Use a Paragraph Style... entry on the Style menu. You can pick up the style of the current paragraph and store it in one of the 21 available styles by using Store Paragraph as Style... entry on the Style menu.

When editing a paragraph style you will see that each has a setting for Select Following Style. For the main body text of your document (which normally has the style name “Default”) you want the style of the new paragraph when you press the [Return] key to be `[Same style]�. However in the case of a “Major” heading style you'd normally want the following style to be set to “Default” because normally a heading will be immediately followed by normal body text.

One great thing about styles is that they are stored away with a document when it is saved so if you spend a little time defining a set of styles that you find attractive you can then use Make New Template... on the Document menu to make a template that is used when you start new documents that will immediately have your own set of personally defined styles instantly available.

Q: What is the largest size for a document?
A: Well, the limit is actually dependent on a lot of things and the more complicated a document is the smaller it's maximum size could be. But for a document of mainly plain text such as this very document the limit is over 100K as shown in the size display within the file manager. However it's probably as well to limit things to this size or smaller (which is probably equivalent to about 30 pages as reported in the status bar at the bottom of the screen).

Keeping documents smaller makes them more manageable and should anything ever go wrong (such as a corrupt disc) you won't lose as much work. Also, while documents can be made bigger there will come a point where they can still be edited but it won't be 
possible to print them because the very act of printing takes a large amount of memory itself. This is particularly true if you are using an OKI printer.

Q: If I split a document into several sections how can I make the page numbers continue in the second (and third...) parts?
A: The common trick to this is to start the second (and subsequent) document with a number of page breaks (]Ctrl]+[Return]) so that the first page of text is page n+1 when the previous document ended at page n.

=== And finally... ===

Q: Does anyone else have any more unanswered questions?
A: You tell me!! If you have questions that you think others may benefit from seeing the answers to in future editions of this document, then please send them to Cliff Lawson, Amstrad plc, 169 Kings Road, Brentwood, Essex, CM14 4EF. Fax: 01277 211350 but please note that I will not reply directly but will only include the questions and answers in future editions of this file. If you have operational questions that you need immediate answers to you should contact the normal support number/address.

[For the technically minded:] I will endeavour to keep an updated version of this file on my Internet web page at the following URL: 
http://web.ukonline.co.uk/cliff.lawson/files.htm
In fact I'll probably have two copies, one in PcW16 format and one in Word for Windows (version 2) format.

If you download the PcW16 format file you will need to use MS-DOS to look at the file called CATALOG.TXT in the \PCW directory on a PcW16 disc and then find the location of an existing PCWnnn.WPD file that can be over-written with the newly downloaded version and just use the DOS COPY command to copy it over.

=== END of FAQ ===

=== Reporting faults ===

The PcW16 has been rigorously tested but in the unlikely even that you find a problem the following is the advice that was given to those involved in the extensive pre-launch testing program. We'd appreciate it if you could report any faults following these guidelines and send the details to LocoScript.

When problems are found there are a few steps that may make it easier for us to identify and fix the problem so I hope you don't mind if I share a few thoughts with you about reporting bugs to us.. 


1) Unless the system has crashed so dramatically that it cannot be used it is always nice to get bug reports written in the WP and printed on a printer rather than hand written. 

2) If an error occurs and you see a warning message on the screen could you write down EXACTLY what it says (you may find that the Print Screen key works at this moment). For example someone might have written that the WP produced an message "There is a problem" (which doesn't mean anything to us) when the actual message is "An error has occurred" (which we know to mean that an attempt has been made to install an invalid font) - this helps us to determine what went wrong.

3) There is nothing as valuable as someone giving us a totally repeatable set of steps to highlight a bug. Just saying that I was typing then the screen went blank doesn't help us trace a fault. While saying that "I was typing Hamlet's soliloquy in 24 point with 210mm wide paper with 25mm indents and a left indent of 10mm and it froze on the second 'r' of 'arrows'. My printer is a Canon BJ (i.e. 360dpi)" tells us exactly how to see the fault. Some of our in house bug testers literally do a save and continue (to floppy, not flash) after every word typed so that we are certain to be able to reproduce a fault if the machine crashes. 

4) It's very important for us to know what version an error has been seen in as we may be able to confirm that we know it is already fixed in a later, internal, version. When telling us the "OS version", from the desktop use the "Setup" menu followed by "set system options". The box at the top will say something like "Currently installed version: v1.00". It's that v1.00 number that we really need.

5) A picture is worth a thousand words. If, for example, you see a word wrapping fault where a word is split in half horizontally it can be very difficult to explain this in words. Try pressing the [Print Screen] key - assuming an error has not crashed the system then hopefully this will print out a picture of the screen that can be sent to us.

6) One of the things it is imperative that we know when you see a fault is what printer you are using. This is because some printers (e.g. OKI) print at 300 dots per inch while some others, (e.g. Canon BJ) print at 360dpi - the way the wordprocessor behaves is entirely different depending on whether you are editing for 300 or 360dpi printing.

7) I can't emphasise enough (so I'll say it again) that for us to fix a bug we have to know exactly how to reproduce the symptoms. If, for example, you see the "An error has occurred" message in the word processor and it then lets you save a copy of the document (usually as "Recovered document") then please, please, please copy it to a floppy in the file manager and send it to us (we'll return your floppy) as it is only by seeing such a broken document (hopefully with copious quantities of description of what you were doing at the time when it crashed) that we can hope to correct the original fault.


8) If you are good enough to send a disc with a file that highlights a problem could we ask that you please, please, tell us the name of the file to look at in the accompanying documentation. We have had several discs with 25-30 files where we've had to search through every document in turn to try and find the file we are supposed to be looking at.

=== End of Document ===
